WRF Hydro GIS Pre-Processing Tools, Version 5.0

Documentation

Kevin Sampson and David Gochis

National Center for Atmospheric Research
Research Applications Laboratory
P.O. Box 3000
Boulder, CO 80307

Updated: April 13, 2018



Contents

1
2

7

SUNMIMIAIY 1etiieeeeeietttttiiee e e e eeetttureae s e e eeetteataasseeeeesaeasssssssseeeeseesssssssssseeersnssssnssssseeeseesssnnnnnssesersessnnnnnns 4

L@ =T V= PP OPPR 4
2 A o Yo | B U o Yo 1Y PSP 5
D28 N o To 1 o To ) a1 -] o USSR 5
2.3 Additional ULIIITIES ....eeieieeeeeeeee e e 5
DY 1 o o1 <IN - 1 - PSP 5
2.5 BA-DIt ArCITECTUIE ...eeieiiieee e s e 6
B T e Yo | B =T o [T PR 6

Introduction to Building the ROULING Grids.........ceeeiiiiiiiiiiiiiiece e 7

(CTTo 1 oI A = | I @oT 0 1Y [ [=T = A o |3 SRR 8
o R € To T o [T g = 1o B ) VA =] o L SUPRRS 8
4.2 A note on GEOGRID projection parameter dependencCies.......cccceeeeeeeviieeieeeeeieeccireee e e e 9
4.3  Compatibility of the pre-processing tools with subsetted domains...........cccceveeiiiieeiciiieeeenns 9
Y o] o 1T IRV A B 1 o o OSSPSR 10
4.5  Geographic Transformation ... e e e e e 10
4.6 Climate and Forecast Conventions (CF) metadata.......ccccocvvveriiiiiiei i 11

Using the WRF-Hydro GIS pre-processing tOOIS..........coieiceirireeeeeeeeeeecirieeeee e e eesctnrreee e e e e e e eennreeeees 11
5.1 TOOl ValIdAtioN c...ceeiiiieeee e e s 12
5.2 Executing the Process GEOGRID Fil@ tOO! ......ceeeiieiieiiiiiiieeiee ettt 12
5.3 INPUL €leVation data ...t e e e e e e e et r b e e e e e e e e e anrrraeeas 13
5.4  Description of Process GEOGRID File tool parameters.......cccccoecevvveeeeeeeeeeccccireeeeee e, 16
5.5 Process GEOGRID File function WOrkflOW ...........ccoieiiiiiiiiiiinececeee e 20
5.6 ANOte about |arge dOMaAiNS .......uvveiiiiiiiiiiciiieeiee e e e e e e e e e e esratrrreeeeeeeeeennnrreneees 21
T A D 1= o T T 4= 4 o V-SSR 21

Understanding TOOI QUEPULS .....cocccuireieeeeeeieiiiirieeeeeeeeeesiitreeeeeeeeeeseaabraeeeeeeeesessnstssseseeeseesessnnsrenenes 21
6.1  Description of OULPUL FIlES.....cuuuiiieiiiiii e e e aarrae s 21
T o - | 1< TP 25
6.3 How to use the WRF-Hydro ‘routing stack’ files .......cccouvreeieiiiiiiiiiiieeeee e, 26
6.4 How to visualize WRF-Hydro ‘routing stack’ files in GIS applications.......c.cccccvveeeeeieeieccnnnnnenn. 27

Other UTHITIES .ot sr e e s ne e e e sneesaneesneeeas 29



2 Y Yo Lo B =GN Y =Y =L =L RPN 29

7.2 Add reach-based rOULING ........oiiiiiiiie et s e e e s e nnee s 29
7.3 Build Groundwater Bucket Parameter Table (GWBUCKPARM) and Grid (GWBASINS)........... 29
7.4 Build Spatial Metadata File .......cccuieiiiiiiee e 30
7.5 Create a Domain Boundary Shapefile .......couuiiiiiiiiiiiiiee e 30
7.6 Examine the Outputs of the WRF-Hydro GIS Pre-proCessor......ccccucuueeevriuieeeeeiiiveeeesnneeeessnenns 31
7.7  Creating a projection definition file from GEOGRID .........cccoeecuiiieiriiieiicieee e 31
7.8  Exporting a grid raster from a GEOGRID variable .........ccccuviiiiiiieiiiiiiieecieee e 31
7.9 Generating the Latitude and Longitude RAStErS ......ccvivviiiiiiiiiiieecceee e 32
S I € |V = g Yoo K DT Yol o) o ] ISR 32
8.1 TerTaiN PrOCESSING ..eevvreiereieietetetetetetetttereeatarererererer————————————————————————ateeaeattttetaaeteaeatterranerrnrernrnnnnes 32
8.2  Station-based watershed delineation ............ooouiiiiiiiiiiiiee e 33
G T U-F- [o] o B 2 - Y=Y N 2 Co TU ) o [ = 2P USRRPRN 34
8.4  Lake/Reservoir incorporation and rOULING..........c.ecvueeriieiiieiieccree et e seeereeeaeereesneesseesaneens 37
8.5  GroundWater PArameters .......ooieiiiiiiiiieeeiie ettt ettt ettt eanee s 40
9  Miscellaneous Topics in the Use of the WRF-Hydro pre-processor .......cccucveeeevecveeeisiiveeeessveennn 41
9.1 Manual Specification of Station POINTS ......ccoeviiiiiiee e e 41
O T Yol T 1 A OB o] 0 0] 721 f [0 1SR 42
10.1 Structure of the scripts in the pre-processing tool .........cccoovveiviivveeiie e, 43
10.2 o [T a gV =d d o[ I a1 ] £ 43
10.3 After making SCript ChANEES ... ..uuviieieeii e e e e e e e s ebrr e e e e e e e e eeaanes 43
11 FUuture CompPatibilities. ..o e e e et e e e e e e e s tarreeeaeeeeeeennnes 43
11.1 Customized Channel INFtIatioN........c.eiiiiiiii e 43
RETEIEINCES. ..ttt s e e et e st e et e e e e e e e e s 44
Acknowledgements

This work was financially supported by the U.S. National Science Foundation, the U.S. National Weather
Service, the National Aeronautics and Space Administration and the Colorado Water Conservation
Board.



The National Center for Atmospheric Research is sponsored by the National Science Foundation. Any
opinions, findings and conclusions or recommendations expressed in this publication are those of the
author(s) and do not necessarily reflect the views of the National Science Foundation.

1 Summary

This document describes the function and use of a stand-alone Python pre-processing utility that is
designed to assist users in the creation of WRF-Hydro routing grids using Esri® ArcGIS Geographic
Information System (GIS) software. As of version 5, all WRF Hydro GIS Pre-processor version numbers
will be linked to the WRF-Hydro version that they support.

2 Overview

The processing workflow for creating WRF-Hydro routing grids is available to users as an ArcGIS Python
Toolbox. Python toolboxes were implemented in ArcGIS Desktop version 10.1 as a way to create custom
geoprocessing tools directly from Python scripts. See Script Customization for more details. All ArcGIS
10.1 and newer installations come with a version of Python installed by default and will be able to view
this Python toolbox, though there may be some python toolbox parameter incompatibilities between
versions. With the ArcGIS 10.2 release, the netCDF4 Python module is packaged with the version of
Python installed by ArcGIS. The authors strongly recommend using ArcGIS 10.3.1 or 10.6. Additionally,
the user must have the ArcGIS Spatial Analyst Extension activated.

NOTE: Due to BUG-000096495, ArcGIS for Desktop versions 10.4 and 10.5 will not be able to reproject
the input DEM using a custom “NULL” transformation. Updates to the WRF-Hydro ArcGIS Pre-processor
utilize a workaround to mimic this transformation, but results created using ArcGIS versions that are
subject to BUG-000096495 may have slightly different variable values than other versions. Testing
reveals that the differences are contained to Fulldom_hires.nc topographically derived variables
TOPOGRAPHY, LINKID, basn_msk, CHANNELGRID, FLOWACC, FLOWDIRECTION, STREAMORDER and
possibly others.

For More information on how to activate Spatial Analyst Extension please visit:

http://desktop.arcgis.com/en/arcmap/latest/extensions/spatial-analyst/enabling-the-spatial-

analyst-extension.htm

Spatial Analyst:

Product page:
http://www.esri.com/software/arcgis/extensions/spatialanalyst

Web help:
http://desktop.arcgis.com/en/arcmap/latest/extensions/spatial-analyst/what-is-the-

spatial-analyst-extension.htm
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Summary of Software Requirements:

= ArcGIS Desktop 10.3.1 or above: Basic, Standard, or Advanced
= Spatial Analyst Extension

Few tools are infallible and this is true for the WRF-Hydro GIS pre-processing tool. There may be
instances when the output from the tool is not precisely what was intended for a given application. The
most common issue that arises is related to how stations are mapped (or ‘snapped’) to a channel
network and, in turn, how watersheds get defined from those locations. Should you run into this issue,
please refer to the section below entitled ‘9.1 Manual Specification of Station Points’ for guidance.

2.1 Tool Purpose

The purpose of the WRF Hydro GIS Pre-Processing Tool is to create the data layers for terrestrial
overland flow, subsurface flow and channel routing processes required by WRF Hydro. The outputs
from these tools are geospatial data layers. The input requirements are all described below.

2.2 Toolbox Design

The toolbox is split across two Python scripts:
\GEOGRID_STANDALONE.pyt
\wrf_hydro_functions.py

The ‘GEOGRID_STANDALONE.pyt’ script is the python toolbox that contains code that ArcGIS uses to
handle and validate parameters. This tool calls functions in the ‘wrf_hydro_functions.py’ script. The
separation of the executing tool from the functions allows for a modular system of tools to be built that
can call functions individually. Thus, many of the tools in the ‘Utilities’ toolset utilize single functions or
a subset of the entire GIS pre-processing workflow. This design provides consistency across tools.
Multiple toolboxes may be developed, all utilizing common code in the function script. The sharing of
code reduces redundancy between tools and allows for rapid development of new tools and utilities.

2.3 Additional Utilities

A few additional utility scripts have been created to facilitate working with WPS-generated “GEOGRID”
files in ArcGIS and to aid in the preparation or review of output from the WRF-Hydro GIS pre-processing
tools. Those utilities are contained in the ‘Utilities’ toolset within the Python Toolbox. These tools are
described below in Section ‘7 Other utilities’.

2.4 Sample Data

Sample input data and output data are provided so that users can see both how to format input data
for the WRF-Hydro pre-processing tool and so they can see what the output should look like. These
sample data are contained within the ‘Standalone_Test_Data’ Zip archive.



2.5 64-bit Architecture

ArcMap and ArcCatalog are 32-bit Windows applications, and by default all geoprocessing is done in
32-bit mode. Processes may either run in the foreground or in the background. The ArcGIS Background
Geoprocessing (64-bit) installation allows users to utilize 64-bit background geoprocessing. All of the
WRF-Hydro GIS pre-processing tools are capable of running in background as well as foreground mode.
For more on background geoprocessing, see the following links.

Foreground and Background Geoprocessing:
http://desktop.arcgis.com/en/arcmap/latest/analyze/executing-tools/foreground-and-

background-processing.htm

Background Geoprocessing (64-bit):
http://desktop.arcgis.com/en/arcmap/latest/analyze/executing-tools/64bit-background.htm

ArcGIS Blog - 64-bit vs. 32-bit Python Explained:
http://blogs.esri.com/esri/supportcenter/2013/07/29/64-bit-vs-32-bit-python-explained/

In order to utilize 64-bit background geoprocessing, Background Geoprocessing (64-bit) must be
installed and background geoprocessing must be enabled in the ArcMap or ArcCatalog session. The user
must also ensure that the Python scripts are being run against a 64-bit Python installation. A check was
put into the Process GEOGRID File tool and the log file created by this tool will record whether or not
64-bit processing is active. If these conditions are met, line 2 of the log file will read “64-bit: True”. It is
not necessary to run the WRF Hydro pre-processing tools in 64-bit or in the background. Simply disable
background geoprocessing to ensure the script tools run in 32-bit mode in the foreground.

NOTE: Occasionally with large grids, a MemoryError will occur related to memory allocation limitations
in 32-bit mode.

2.6 Tool Testing

Testing was carried out on a Windows 10 Pro 2.59 GHz Intel Core i7 PC, 16GB RAM, ArcGIS 10.3.1.4959
with Background Geoprocessing (64-bit).
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3 Introduction to Building the Routing Grids

WRF-Hydro routing functions are executed on a different set of grids than the column land surface
model (LSM) grid. The column LSM grid is the same as that of the WRF model when WRF-Hydro is run
in a fully coupled mode with WRF. Because the WRF Preprocessing System (WPS) contains a number
of functions that aid in the generation of the LSM grid users may utilize the WRF WPS ‘geogrid.exe’
program to generate “GEOGRID” files which define the domain, resolution, and other spatially varying
and static grids used by the column LSM and the WRF model. These GEOGRID files typically have names
like ‘geo_em.d01.nc’. For more on GEOGRID, see:

http://www2.mmm.ucar.edu/wrf/users/docs/user guide V3/users guide chap3.htm

Although WRF-Hydro routing functions are typically run on a finer grid than the land model, the two
grids must be compatible. For example, the WRF-Hydro routing grid must have the same extent as the
WREF grid, and the routing grid must nest exactly within the land model grid. All routing grids must share
a common domain extent, cellsize, and dimensionality (rows & columns). The WRF-Hydro GIS pre-
processing tools handle the building of the WRF-Hydro ‘routing stack’; a set of grids with a resolution
based on user input parameters and an existing WRF GEOGRID file.

100m

—A Regridding Factor: 10

!
1000m
Figure 1. Nesting of WRF-Hydro routing grid cells (red boxes) within a WRF grid cell (black box).
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The regridding factor shown in Figure 1 is an integer used to divide the WRF cellsize and produce the
routing resolution. In this example, a WRF cellsize (DX, DY) of 1000m and a regridding factor of 10 yields
100m cells for the WRF-Hydro routing grid. Refer to Table 3 for more information.

4 Geospatial Considerations

Dealing with terrain data is a highly spatial process, to which GIS applications are well suited. Although
much of the processing done on the grids is not spatial, knowledge of the coordinate reference system
(CRS) and ability to translate between grids with different CRS is important. The WRF model is
configured to run using a limited set of projected coordinate systems, yet many stream gages are
georeferenced using a geographic coordinate system such as WGS84. Further, most elevation datasets
are produced using varying regional projected or geographic coordinate systems and must be re-
projected to the WRF CRS in order to be used. This section will deal with the geospatial considerations
used in the WRF-Hydro GIS pre-processing tool.

4.1 Coordinate Systems

The WRF model defines the CRS of its domains using global attributes in the GEOGRID file. The
coordinate system is interpreted using the ‘MAAP_PROJ’ global attribute from the GEOGRID file. Values
of the MAP_PROJ attribute and the associated projected coordinate system name are given in Table 1.
Once the coordinate system is identified, additional attributes are read to obtain the parameters that
define the unique WRF domain projection.

MAP_PROJ Projection Name

1 Lambert Conformal Conic
2 Polar Stereographic

3 Mercator

6 Cylindrical Equidistant

Table 1. WRF-supported projected coordinate systems

GEOGRID Attribute Projection Parameter Associated Projection

TRUELAT1 Standard Parallel 1 All (required)

TRUELAT2 Standard Parallel 2 Lambert Conformal Conic (optional)
STAND_LON Central Meridian All (required)

MOAD_CEN_LAT Latitude of Origin Lambert Conformal Conic (required)
POLE_LAT Pole Latitude Cylindrical Equidistant (optional)
POLE_LON Pole Longitude Cylindrical Equidistant (optional)

Table 2. WRF GEOGRID projection parameters

All of the supported WRF coordinate systems may be used, with the exception of a configuration of the
Cylindrical Equidistant projection which allows for the North Pole to be rotated away from 90N, OE. This
configuration is known as ‘rotated pole’, and is not supported by the ArcGIS Projection Engine. If
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encountered, any tool in the toolbox that attempts to read the GEOGRID file will produce a warning
and exit.

The GEOGRID file may or may not contain all of the projection parameters listed in Table 2. In the course
of generating a projection definition from the GEOGRID file, the projection type (‘MAP_PROJ’) is read
first, and any available projection parameters are then read. An Esri® projection string is generated
based on the projection and available parameters, which can be converted to a spatial reference object
in the Python ArcGIS API. This spatial reference object is used to define the CRS of all WRF-Hydro grids.
Additionally, a PR0OJ.4 string is provided to the user for use in applications such as QGIS or GDAL.
Examples of the Esri® and PROJ.4 definitions of the same WRF CRS are listed below:

Example Esri® Projection String:

PROJCS [ 'Sphere Lambert Conformal Conic',GEOGCS['GCS Sphere',DATUM['D Sphere',
SPHEROID|['Sphere',6370000.0,0.0]],PRIMEM['Greenwich',0.0],UNIT['Degree',0.017
4532925199433]], PROJECTION]| 'Lambert Conformal Conic'],PARAMETER['false eastin
g',0.0],PARAMETER['false northing',0.0], PARAMETER['central meridian', -
105.0], PARAMETER[ 'standard parallel 1',38.25],PARAMETER(['standard parallel 2'
,41.0], PARAMETER[ 'latitude of origin',39.7632102966],UNIT['Meter',1.0]];-
37188300 -29513500 10000;-100000 10000;-100000
10000;0.001;0.001;0.001;IsHighPrecision

PROJ.4 String:

+proj=lcc +lat 1=38.25 +lat 2=41 +lat 0=39.7632102966 +lon 0=-105 +x 0=0
+y 0=0 +a=6370000 +b=6370000 +units=m +no defs

4.2 A note on GEOGRID projection parameter dependencies

The dimensions ‘west_east’ and ‘south_north’ contain the X and Y dimensions, respectively, in the
GEOGRID file. The global attributes ‘MAP_PRQJ’, ‘corner_lats’, ‘corner_lons’, “TRUELAT1’, ‘TRUELAT2’,
‘STAND_LON’, and ‘MOAD_CEN_LAT’, ‘POLE_LAT’, and ‘POLE_LON’ contain the values for the map
projection, corner latitude, corner longitude, standard parallel 1, standard parallel 2, central meridian,
latitude of central origin, pole latitude, and pole longitude, respectively. These are used to produce the
PRJ file (.prj) and properly project the raster. If the names of any of these elements changes in the
future, the script will need to be modified to reflect the change.

Note: Even if WRF does not use a particular projection parameter for the coordinate system, such as
STAND_LON in the case of the Mercator projection (‘MAP_PROJ’=3), ArcGIS requires a valid value.

4.3 Compatibility of the pre-processing tools with subsetted domains

Many programs such as NCO and NCL will allow a user to subset a 2D netCDF file. However, only files
that are generated using the WPS geogrid.exe program may be used as input to the WRF-Hydro ArcGIS
Pre-processing tools. This is because the georeferencing of GEOGRID files requires the corner latitude
and longitude to be known. This is stored in the ‘corner_lats’ and ‘corner_lons’ global attributes in a
WPS-generated GEOGRID file. If a user wishes to subset a WRF domain, they must also update the
values in these attributes in order for the domain to be properly georeferenced.



4.4 Sphere vs. Datum

The WRF model, as with many other models, is executed assuming a spherical Earth. Generally,
atmospheric circulation models use a spherical Earth model while terrestrial geospatial data uses a
spheroidal earth model. In the case of WRF ARW, the Earth radius is 6,370,000m. However, most input
data, such as elevation or landuse, is specified using a using a spheroidal (elliptical) datum to account
for the flattened shape of the Earth, which is closer to an oblate spheroid. Appropriate care must be
taken by the user to limit positional errors that may be introduced into the model because of the
differing Earth models (sphere or spheroid) used in the input data. This topic has been examined by
many, though David et al (2009) and Monaghan et al (2013) discuss the topic in relation to hydrological
modeling and WRF, respectively. As noted in Monaghan et al (2013), users of models such as WRF
should ensure that the terrestrial input data are consistently mapped.

A spherical datum (‘D_Sphere’) is used for all WRF projections in ArcGIS, and the Earth radius is always
set to 6370000.0m. The input elevation raster and reservoir shapefile data may be in any defined
coordinate system that can be transformed to the WRF sphere. Thus, a geographic transformation
method is necessary to allow for conversion of data between a spheroid and the WRF sphere. The next
section, ‘4.5 Geographic Transformation’, will address this topic.

Note: Problems may arise as a result of the WRF geogrid.exe program treating geodetic latitude as
though it were geocentric latitude (Monaghan et al 2013). Although the “Process GEOGRID File” tool
uses the user-supplied elevation instead of the GEOGRID file elevation, it does resample the ‘landuse’
grid in the GEOGRID file to the routing grid resolution. Care should be taken to note any spatial shifts
between elevation-derived grids (‘TOPOGRAPHY’, ‘CHANNELGRID’) and the ‘landuse’ grid in the output
files.

Note: If a different sphere radius is desired, the user may alter the floating-point global variable
‘sphere_radius’ in the ‘wrf_hydro_functions.py’ script. This is not recommended, as WRF has a set
sphere radius.

4.5 Geographic Transformation

Any time that GIS applications must convert geospatial data between datums (for example between a
spherical datum such as WRF and a spheroidal datum such as WGS84), a transformation is necessary.
Transformations are used in GIS processes to minimize positional error. Failing to apply an
appropriate transformation between spherical and spheroidal datums, such as simply treating
geodetic latitudes as geocentric, can result in significant (up to 20km North-South) locational shift in
the spatial features contained in the data. This shift is greatest at 45° latitude (David et al 2009). No
predefined transformation exists in ArcGIS between a sphere and spheroid, thus a custom
transformation must be created. As suggested by Cedric David, a ‘geocentric translation’ may be
defined in ArcGlIS, leaving all parameters ‘0’ when translating between sphere and spheroid. For more
information, see the following resources:

http://www.crwr.utexas.edu/gis/gishydro06/SpaceAndTime/SphereVsSperoid2006.htm

10


http://www.crwr.utexas.edu/gis/gishydro06/SpaceAndTime/SphereVsSperoid2006.htm

However, the main focus of the WRF-Hydro ArcGIS Pre-processing tool is to ensure that WRF data are
mapped consistently, and ensure geospatial features in one dataset are appropriately mapped onto
other datasets. This minimizes any positional error between datasets at the cost of accurate
geographic positioning on the model sphere. In the case of a WRF domain created using the WPS
geogrid.exe program, the terrestrial input data is assumed to be on a sphere and are thus mapped to
the WRF spherical datum without transformation. Thus, for WPS-created grids, it is appropriate to use
a Null Transformation in order to map other terrestrial datasets to the WRF spherical datum such that
spatial features (such as mountains, river valleys) will be mapped consistently with the geospatial data
used in WRF. The goal is to line up the model’s terrestrial data with the other terrestrial data layers
(landuse, landmask, elevation, etc.) for consistency of spatial features in the model; thus a Null
Transformation is used.

When re-projecting the user-supplied high-resolution elevation data to the WRF-Hydro coordinate
system, the WRF-Hydro ArcGIS pre-processing tools will create a new custom geotransformation file
named ‘GeoTransform_Null_WRFHydro.gtf’ in the user’s CustomTransformations folder. By default,
this is a “Null Transformation”, which will not apply a transformation between the datums. If another
transformation is desired, the user may alter the string-type global variable ‘customGeoTransfm’ in
the ‘wrf_hydro_functions.py’ script, which describes the desired transformation method and
parameters. For more on Custom Geographic Transformations, see:

http://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/create-custom-

geographic-transformation.htm

4.6 Climate and Forecast Conventions (CF) metadata

The Climate and Forecast (CF) conventions for netCDF data, also called CF-netCDF, is a set of spatial
and non-spatial metadata that may be added to netCDF format files which describe the datain a
standard way. Recent editions of WRF-Hydro allow the limited output of CF-compliant metadata with
WREF-Hydro output files. This represents an improvement in the standardization and usability of WRF-
Hydro output files in desktop and server-based geospatial applications. The CF-conventions represent
a wide range of possible metadata tags, and not all are supported by all geospatial applications. For
checking the level of compliance for any particular file, a compliance checker may be utilized, and
multiple websites are listed for this purpose, here: http://cfconventions.org/compliance-checker.html

For more information on the WRF-Hydro spatial metadata files, see 7.4 Build Spatial Metadata File.

For more information on Climate and Forecast (CF) Conventions, see http://cfconventions.org/

5 Using the WRF-Hydro GIS pre-processing tools

To view and open the toolbox, unzip the package to a location on your disk. From ArcCatalog (or the
ArcCatalog tab within ArcMap), navigate to the location of the standalone tool folder. The Python
toolbox exists as a .pyt file, and will behave like a regular ArcGIS ArcToolbox tool (or .tbx file) within
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ArcGIS. The ‘GEOGRID_STANDALONE’ toolbox contains both a ‘Processing’ and ‘Utilities’ toolset. The
processing toolset contains a single ‘Process GEOGRID File’ script tool. The ‘Utilities’ toolset contains
multiple script tools for performing additional functions. Users may customize the toolbox and add
any scripts or additional functionality necessary for processing WRF-Hydro spatial data, as long as
these tools conform to the existing toolbox structure. For more on Python Toolboxes, see:

http://desktop.arcgis.com/en/arcmap/latest/analyze/creating-tools/a-quick-tour-of-python-

toolboxes.htm

5.1 Tool validation

The script tools provide some basic validation of input parameters, and will not run until all required
inputs are entered and validated. Some validation is performed after the tool execution begins. These
types of validations will cause the tool to fail if an invalid value is entered. Check the tool messages in
the ‘Results’ tab of ArcMap or ArcCatalog for more information in the event of a tool failure.
= §9 GEOGRID_STANDALONE.pyt
= & Processing
Z Process GEOGRID File
= & Utilities
Z' Add Lake Parameters
%' Add reach-based routing
&' Build Groundwater Inputs
%' Build Spatial Metadata File
&' Create Domain Boundary Shapefile
&' Examine Outputs of GIS Preprocessor
&' Export ESRI projection file (PRJ) from GEOGRID file
&' Export grid from GEOGRID file
&' Generate Latitude and Longitude Rasters
Z' Raster Grid to FullDom format

Figure 2. Catalog Tree view of the Python Toolbox in ArcCatalog.

5.2 Executing the Process GEOGRID File tool

Open the ‘Process GEOGRID File’ script tool by double-clicking on it, or right-click and select Open. A
tool dialog will open, with five required inputs, as well as optional inputs and several default parameter
values supplied. Once all required and any optional inputs are given, click OK to execute.

Although environments can be specified at the tool level by clicking on the ‘Environments...” button,
any settings at this level will be overridden by environment settings in the Python scripts. See the
following link for more information on environment hierarchy in ArcGIS:

http://desktop.arcgis.com/en/arcmap/latest/analyze/modelbuilder/a-quick-tour-of-managing-

environments.htm

The ‘Process GEOGRID File’ tool will create a ‘scratchdir’ directory in the directory provided for the
Output Zip File parameter. This scratch directory is a temporary storage location for intermediate
datasets. If the tool executes successfully, the scratch directory will be deleted. If an error causes the
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tool to terminate prematurely, the user will need to manually delete the ‘scratchdir’ directory before
re-running the tool.

Note: In some versions of ArcGIS, users may see a warning when trying to populate the python toolbox
parameters. The warning, shown in Figure 3, may be ignored by clicking “Yes”.

Windows Security Warning X

| 'q| An ActiveX control on this page might be unsafe to
. interact with other parts of the page. Do you want to
h allow this interaction?

Yes

Figure 3. ActiveX warning in certain versions of ArcGIS.

5.3 Input elevation data

The selection of a high-quality and high-resolution terrain dataset is very important for proper
definition of the terrain-based parameters as well as accurate location of streams. If good data goes
into the tools, good data has a better chance of coming out of them. The elevation data that goes into
the tool should already be processed for hydrologic connectivity to ensure that no major problems exist
that would break or alter the river network dramatically.

The ‘Process GEOGRID File’ tool will resample and regrid the input elevation data to the routing grid
resolution and extent before performing the terrain processing. A large difference in scale between the
resolution of the input elevation grid and the routing grid resolution introduces more error into the
hydrology of the output data. If possible, try to select a hydrologically processed elevation dataset that
is near the resolution of the routing grid. This ensures that the hydrologic conditioning process is not
hindered by artifacts introduced in the resampling step.

Hydrologically conditioned elevation datasets are often combined with hydrographic data such as
shapefiles of rivers or lakes. Large elevation data collections typically exist as tiles or multiple regional
rasters. Using a mulit-raster format such as the Mosaic Dataset in an Esri® file Geodatabase is a good
way of combining multiple elevation rasters for use with the ‘Process GEOGRID File’ tool. For more on
creating a mosaic dataset, see:

http://desktop.arcgis.com/en/arcmap/latest/manage-data/raster-and-images/what-is-a-mosaic-
dataset.htm

An alternative method for storing a mosaic DEM is in the GDAL Virtual Raster (VRT) format. This XML
file will store metadata and rules for dynamically creating a raster mosaic. Initial testing shows this
format will work as input to the Process GEOGRID File tool. For more information on the VRT format,
see:

http://gdal.org/1.11/gdal vrttut.html

Examples of hydro-elevation collections are listed below:
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53.1

5.3.2

HydroSHEDS

The Hydrological data and maps based on Shuttle Elevation Derivatives at multiple Scales
(HydroSHEDS; http://hydrosheds.cr.usgs.gov/index.php) has been tested for compatibility with
the WRF-Hydro GIS pre-processor. HydroSHEDS data are hydrologically processed elevation data
at 3 arc-second (~¥90m), 15 arc-second (~450m), and 30 arc-second (~900m) resolutions, that
extend globally to about 60° north and south of the Equator. It is important to note that
HydroSHEDS gives elevation values to a precision of 1 meter (no sub-meter elevation values).
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Figure 4. Mosaic of HydroSHEDS 90m elevation data.

NHDPlus/NED

The National Elevation Dataset (NED), which the National Hydrography Dataset Plus, Version 2
(http://www.horizon-systems.com/nhdplus/NHDPlusV2 home.php) was built on has been
tested for compatibility with the WRF-Hydro GIS pre-processor. This elevation data covers the
Continental United States at 10m and 30m resolution, as well as Hawaii and Puerto Rico at 10m

resolution. The data provide elevation precision to the nearest centimeter. It is important to note
that the NED provides elevation in cm above sea level. The values must be converted to meters
before being used in the ‘Process GEOGRID File’ tool. This can be easily done within the mosaic
dataset using a Unit Conversion Raster function or in the VRT format using the <scale> tag.
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Figure 5. Mosaic of NHDPlus NED Snapshot 30m elevation data (excluding Hawaii and Puerto Rico).

5.3.3 EU-DEM

The EU-DEM elevation dataset (https://www.eea.europa.eu/data-and-maps/data/copernicus-
land-monitoring-service-eu-dem) is not yet fully compatible with the WRF-Hydro GIS pre-
processor. This dataset covers the geographic region of the European Union at 1 arc-second
(~30m) horizontal resolution and provides precision to the nearest centimeter. Preliminary
testing revealed that ocean areas are given a value of 0 elevation rather than NoData, causing
stream definition and channelization over ocean areas. The elevation data will need to be pre-
processed and ocean values masked to NoData to eliminate elevation values over ocean areas
before running the tool.
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Figure 6. Mosaic of EU-DEM 230 elevation data.

5.4 Description of Process GEOGRID File tool parameters

&' Process GEOGRID File

— |
% Input GEOGRID File @ Process GEOGRID File
Forecast Points (CSV) (optional) gg%ggﬂg?ﬁ _an'\:nFéJB\éVRF
lle In Ne
| | @ format and uses the HGT_M
Mask CHANNELGRID variable to forecast basins? (optional) ?ergolilrtllgnagller:fgl:ltﬂ?llg':;ﬂﬁ
Create reach-based routing (RouteLink) files? (optional) E;%?g;zli;:gr;:isgéu;;n
: output.
[ Create lake parameter (LAKEPARM) file? (optional)
Reservoirs Shapefile or Feature Class (optional)
=)
% Input Elevation Raster
Regridding (nest) Factor
10]
Number of routing grid cells to define stream
200 |
Qutput ZIP File
| WRF_Hydro_routing_grids.zip | @
% parameter Values
OVROUGHRTFAC Value
E 2]
RETDEPRTFAC Value
[ 2]
< >
‘ oK | | Cancel | | Environments... | ‘ << Hide Help | | Tool Help

Figure 7. Tool dialog for the Process GEOGRID File tool.



54.1

5.4.2

5.4.3

Input GEOGRID file (required)

This is the input GEOGRID file in netCDF format. This file must contain dimensions ‘west_east’
and ‘south_north’, as well as the gridded variables ‘HGT_M’ and ‘LU_INDEX’ , which is the grid
of elevation values and a land use grid. Both of these variables are defined on the mass (:stagger
="M") computational. The GEOGRID file is used to initiate all of the WRF-Hydro routing grids,
and is typically produced using the WRF Preprocessing System (WPS) geogrid.exe program. See
the following link for more information on creating the input GEOGRID file:

http://www2.mmm.ucar.edu/wrf/users/docs/user guide V3/users guide chap3.htm

Forecast points (CSV) (optional)

This optional parameter requires a Comma-Separated Values (CSV; .csv) formatted file of gage
locations in latitude/longitude coordinates (WGS84). This ASCII file should contain a 1 row
header with gage location information on subsequent rows. The CSV file must contain a
longitude field named ‘LON’ and a latitude field named ‘LAT’ as well as an ID field named ‘FID’
in order to be read properly, and no header names are allowed to contain spaces or special
characters. An example of the text in a valid input file is given below:

FID,LON,LAT, STATION, Name
15,-105.92833,40.08139,Fraser_at_Granby, 9033300
18,-105.9,40.12083,COLO_nr GRANBY, 9019500

20,-106.3333,39.8803,Blue R blw Grn Mtn, 9057500

If forecast points are provided, the output ‘Fulldom_hires.nc’ files will contain valid values in
both the ‘basn_msk’ and “frxst_pts’. The ‘frxst_pts’ variable is a grid of forecast point locations
snapped to the CHANNELGRID with a default snap tolerance of 1 pixel. The ‘basn_msk’ variable
is a grid of the basins delineated from a location just downstream of each gage (see ‘9.1 Manual
Specification of Station Points’ and ‘8.2 Station-based watershed delineation’ for more
information).

Mask CHANNELGRID variable to forecast basins (optional)

This optional Boolean (TRUE/FALSE) parameter asks the user whether or not to mask the output
‘CHANNELGRID’ grid to the basins delineated based on the provided Forecast Points CSV file.
The option is only available if a CSV file is provided in the ‘Forecast Points (CSV)’" parameter. If
TRUE (Checked), the derived gauged basins will be used to mask the channels in the
‘CHANNELGRID’ grid. The resulting ‘CHANNELGRID’ grid will contain values of 0 for channels
inside a gaged basin, values of -1 for channels outside of gaged basins, and -9999 for all other
areas. Masking out unwanted channels can result in a significant computational savings because
routing is not performed on channels with grid values of -1.
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5.4.4 Reach-based routing (Route Link) files (optional)

5.4.5

5.4.6

This optional Boolean (TRUE/FALSE) ‘Create reach-based routing (RouteLink) files?’ parameter
will produce additional output files that facilitate reach-based routing in WRF-Hydro. All channel
elements will be vectorized and channel attributes and topology are summarized in the
Route_Link.nc output file. Additional files created by this option include a ‘LINKID’ variable in
the ‘Fulldom_hires.nc’ file, a grid of the channels with values corresponding to the ‘link’ variable
in the Route_Link.nc file and a streams.shp line shapefile for plotting the streams in a GIS. See
‘8.3 Reach-Based Routing’ for more information on how reach-based routing is performed.

Adding reservoirs (optional)

The optional Boolean (TRUE/FALSE) ‘Create lake parameter (LAKEPARM) file?’ parameter will
produce additional output files that facilitate the addition of reservoirs in WRF-Hydro. If TRUE
(checked), the ‘Reservoirs Shapefile or Feature Class’ parameter will become active and a
polygon shapefile or feature class will be required. A long integer field will be created called
‘NEWID” using a 1-n range of integer values and the outputs will reflect these new IDs.

This option will add a ‘LAKEPARM.nc’ file to the output Zip archive and the ‘CHANNELGRID’
variable in the ‘Fulldom_hires.nc’ file will be altered to include lakes. This alteration includes
adding lake outlet points to the ‘CHANNELGRID’ grid and masking channel elements where they
coincide with a lake cell. The LAKEGRID will be populated with the IDs and spatial location of the
lakes as well.

Notes:

This option will fundamentally alter and break the ‘CHANNELGRID’ grid stream connectivity. The
reservoir routing option will need to be activated in WRF-Hydro in order to use the resulting
routing grids. See ‘8.4 Lake/Reservoir incorporation and routing’ for more information on adding
reservoirs to the routing grids.

Input Elevation Raster (required)

This required ‘Input Elevation Raster’ parameter allows the user to provide a high-resolution
digital elevation model (DEM) from which to derive the output layers. This grid must be an
ArcGIS supported raster or mosaic dataset format, have the coordinate system defined, and
cover the entire extent of the input GEOGRID domain. The terrain processing is more likely to
be successful if the input DEM has been hydrologically processed to ensure continuous flow
paths. See ‘5.3 Input elevation data’ for more information on hydrologic processing and
supported elevation datasets.

Note: The vertical units must be in meters above sea level (m).
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5.4.7 Regridding (nest) Factor (required)

The required ‘Regridding (nest) Factor’ parameter allows the user to set the output cell size for
the derived datasets based on a relationship to the cell size in the GEOGRID file. The output
high-resolution grids must be able to nest perfectly within the coarse GEOGRID resolution, and
so the GEOGRID grid resolution will be divided by the regridding factor. Several examples are
given in Table 3 for a 1000m input GEOGRID resolution.

GEOGRID resolution Regridding Factor Routing resolution

1000m 10 100m
1000m 5 200m
1000m 4 250m

Table 3. Regridding factor effect on routing grid cellsize.

5.4.8 Number of routing grid cells to define stream (required)

The required ‘Number of routing grid cells to define stream’ parameter is the number of
contributing cells on the routing grid used to initiate a stream segment on the CHANNELGRID.
The number of contributing cells is given in the derived flow accumulation grid ‘FLOWACC'.
Smaller thresholds will yield higher drainage density in the resulting channel network. See Figure
8 for examples of channel density based on this parameter.

1
1km?

Figure 8. Effect of contributing area threshold on stream density overlaid on elevation.

0.01km?

When choosing the number of cells for defining a stream, remember that the area depends on
the resolution of the grid. If the routing grid is 100m x 100m, then each cell is 10,000m? and a
threshold of 100 would yield a stream below every 1km? of contributing area. This parameter
will alter the distance that overland flow must travel before reaching a channel and will control
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the density of the resulting channel network. Several examples are given in the following table
for a parameter value of 100 using different routing grid resolutions:

Routing resolution Contributing cells Contributing area

100m 100 1,000,000m?
200m 100 4,000,000m?
500m 100 25,000,000m?

Table 4. Minimum contributing area for stream definition based on different routing resolutions.

5.4.9 OQutput ZIP File (required)

This required parameter is the directory and filename (.zip) of the output from the tool. This can
be set to any location and filename that you choose, as long as you have read/write access to
this location. The output format will be a ZIP archive containing compressed versions of all
output files. Be sure to include the .zip file extension.

Note: A common default in ArcGIS is to set the output for geoprocessing tools to write to a
geodatabase (.gdb). This tool will fail with an obscure error message if the user attempts to write
the output ZIP file to a geodatabase location.

5.4.10 Other Parameters (optional)

There are two floating-point parameter values: ‘OVROUGHRTFAC’ and ‘RETDEPRTFAC’. The default
values for these grids are 1.0. Any valid number will be taken and these variables will contain constant-

value grids with those values. Spatially-varying grids may be substituted at a later time if desired. See

‘6.3.1 Using alternate grids in WRF-Hydro ’ for more information on using alternate grids.

5.5 Process GEOGRID File function workflow

The WRF-Hydro preprocessing tool workflow proceeds as follows:

1)

2)

3)

4)

The input WPS GEOGRID variables and attributes are accessed and a spatial reference object is
constructed from the projection parameters, along with a properly georeferenced grid (variables:
HGT_M and LU_INDEX). This function is called ‘georeference_geogrid_file’.

Empty netCDF-CF files are created to store the output variables and CF-metadata for both the
“Fulldom_hires.nc” file and the “GEOGRID_LDASOUT _Spatial_Metadata.nc” file

High Resolution topography is created for the domain, based on the input elevation raster. This grid
is projected and then resampled using bilinear interpolation to the output resolution provided by
the ‘Regridding (nest) Factor’ parameter. The WRF GEOGRID resolution is divided by the ‘Regridding
(nest) Factor’ to arrive at the routing grid resolution. This function is called
‘create_high_res_topography’.

The routing grid is used to generate 2D latitude and longitude grids, according to the geographic
coordinate system defined on the WRF sphere (radius = 6370000.0m). A reprojection is used to
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convert from the projected WRF coordinate system to a geographic coordinate system on the same
sphere. This function is called ‘create_lat_lon_rasters’.

5) Spatial analysis functions are performed on the high resolution elevation grid (created in step 3).
The high-resolution elevation data is hydrologically re-processed in this step. First, the elevation
layer has all depressions filled using the ‘Fill’ algorithm. Next, flow direction and flow accumulation
are calculated. The basin size threshold parameter is used to create the CHANNELGRID layer.
Stream order is then calculated from the CHANNELGRID layer. If a gages CSV file is provided,
additional layers are calculated after applying the ‘Snap Pour Point’ and ‘Watershed’ Spatial Analyst
tools. Further, if the routing table or reservoir parameter table are requested, those functions are
called from within this function. All output layers are converted to numpy arrays and inserted into
the ‘Fulldom_hires.nc’ netCDF file, compressed (.zip) and returned to the user. This function is called
‘sa_functions’.

6) Default groundwater 2D and 1D parameter files are created to support the groundwater options in
WRF-Hydro. These functions are called 'build_GW _Basin_Raster’ and ‘build_GW _buckets’.

7) Intermediate files and the temporary ‘scratchdir’ directory are deleted.

5.6 A note about large domains

Many intermediate rasters are held in memory during processing, which allows for quick access.
However, the ability to store raster data in memory is limited by the memory capacity of the machine
performing the processing. Some large domains will require substantial resources when high resolution
or very large domains are required. Be aware that this limitation may manifest itself through non-
descriptive error messaging upon failure of the process. Always check the tool’s results and messages
by viewing the ‘Results’ tab in ArcMap or ArcCatalog for more information.

5.7 Debugging

If the tool fails to execute, the first place to look will be the ‘Results’ tab in ArcMap or ArcCatalog. In
the messages section, an error message may be printed. See Figure 10. Messages returned by the
‘Export grid from GEOGRID file’ tool as viewed in the ‘Results’ tab of ArcMap. for an example of the
Results tab. This should yield what line of the code the error occurred on, provide the python traceback,
and may give a message to indicate the type of failure.

Note: If the tool fails to run, the user will be required to manually delete the ‘\scratchdir’ folder, which
is a temporary directory created to store intermediate files. This can be found in the directory the user
provided for the output Zip archive.

6 Understanding Tool Outputs

6.1 Description of output files

The ‘Process GEOGRID File’ tool creates a Zip archive of output files according to the options provided
to the tool. There will be at least four netCDF files; one spatial metadata file describing the LDAS grid
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(‘GEOGRID_LDASOUT Spatial_Metadata.nc), one 2D file describing the routing grid
(‘Fulldom_hires.nc’), a 2D groundwater basin file, and a 1D groundwater basin parameter file. The
‘Fulldom_hires.nc’ file will contain between 12 and 13 2-dimensional gridded netCDF variables. The
output Zip file may additionally include shapefiles (.shp and accompanying files) describing lakes or the
stream network, and netCDF 1-dimensional parameter tables (.nc) describing lakes or the stream
network. All variables in the ‘Fulldom_hires.nc’ file will have the same grid dimensions. The x-dimension
is always ‘X’ and the y-dimension always ‘y’. Below is an alphabetically sorted list of gridded variables
that are created by the ‘Process GEOGRID File’ tool, and Table 5 contains descriptions of each grid.

Fulldom_hires.nc file:

CHANNELGRID - The channel grid. Channel pixels = 0, non-channel pixels = -9999. If the ‘Mask
CHANNELGRID to basins?’ option is set to TRUE (checked), the output will be masked to
the gaged basins provided, where non-gaged channels are given a value of ‘-1’. If lake
routing is activated, lake outflow points will be identified by the lake ID value.

FLOWACC - Flow accumulation grid. This grid gives the number of contributing cells for each
cell in the domain. This grid is provided for convenience and is not read by WRF-Hydro.
For more information, see:

http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/flow-

accumulation.htm

FLOWDIRECTION — Flow direction grid. This grid gives the direction of flow using the D8
algorithm between each cell and the steepest downslope neighbor according to Jenson
and Domingue (1988). The result is an integer grid with values ranging from 1 to 128.
The values for each direction from center are:

32 | 64 128

16 1

8 4 2

Figure 9. Flow direction grid values from the analysis cell (blue).

For more information, see: http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-

analyst-toolbox/flow-direction.htm

frxst_pts — Gage location grid. If a gage CSV file is provided, the grid will have a cell identified at
the location of each gage in the gage CSV file. If no input CSV gage location file is
provided, this grid will be uniform with values of ‘-9999’. Gage pixels are numbered in
the same way as the ‘basn_msk’ grid. NoData cells are given a value of -9999’.

basn_msk — Forecast basins grid. If a CSV gage location file is provided, catchments are
delineated from a point that is up to 3 pixels (3 * cellsize) downstream of the gage
coordinates. This distance can be modified by altering the ‘walker’ global variable in the
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‘wrf_hydro_functions.py’ script. If masking of the ‘CHANNELGRID’ is selected, this layer
is the mask. Basins are numbered according to the values in the ‘FID’ field of the input
gage CSV file. If no gage location file is provided, this grid will be uniform with values of
-9999’. NoData cells are given a value of ‘-9999’.

LAKEGRID — The lake grid. If the option to create the lake parameter file is TRUE (checked) and
a lake shapefile is provided, this grid will contain ID values for each lake. If FALSE, this
grid will be uniform with values of -9999. See ‘8.4 Lake/Reservoir incorporation and
routing’ for more information on how the LAKEGRID is created.

landuse — This is the same data as the ‘LU_INDEX’ variable in the GEOGRID file, but resampled
using Nearest Neighbor assignment to the resolution of the routing grid. This grid is
provided for convenience and is not read by WRF-Hydro. For more information on the
resampling method, see: http://desktop.arcgis.com/en/arcmap/latest/tools/data-

management-toolbox/resample.htm

LATITUDE - Grid of the latitude at the center of each grid cell, in a geographic coordinate system
based on a sphere of radius 6370000.0m (EMEP sphere, wkid: 104128). For more
information on how latitude is derived, see ‘7.9 Generating the Latitude and Longitude
Rasters’.

LINKID — The channel ID grid. This grid provides a unique integer identifier for each channel
segment that is defined in the ‘link’ variable of the ‘Route_Link.nc’ file and the ‘ARCID’
field in the ‘streams.shp’ shapefile. The ‘LINKID’ grid will only be created if the option
‘Create reach-based routing files?’ is TRUE (checked).

LONGITUDE — Grid of longitude value at the center of each grid cell, in a geographic coordinate
system based on a sphere of radius 6370000.0m (EMEP sphere, wkid: 104128). For more
information on how longitude is derived, see ‘7.9 Generating the Latitude and Longitude
Rasters’.

OVROUGHRTFAC — OVROUGHRTFAC parameter. Currently set to a default of 1.0. This default
value may be changed by providing an alternate value to the ‘OVROUGHRTFAC Value’
parameter (under ‘Parameter Values’) of the ‘Process GEOGRID File’ tool.

RETDEPRTFAC — RETDEPRTFAC parameter. Currently set to a default of 1.0. This default value
may be changed by providing an alternate value to the ‘RETDEPRTFAC Value’ parameter
(under ‘Parameter Values’) of the ‘Process GEOGRID File’ tool.

STREAMORDER — Stream order grid, calculated using the Strahler method (Strahler 1957).
NoData cells have values of ‘-15’. More information on derivation of stream order can
be found here:

http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/stream-

order.htm
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TOPOGRAPHY — Elevation grid. The units of elevation are the same as the ‘Input Elevation

Other files:

Raster’ dataset, which should be in meters (m). This grid is derived from the elevation
values in the ‘Input Elevation Raster’, but has been converted to floating point,
resampled to the routing grid resolution, and filled according to the method described
here:

http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/fill.htm

See ‘8.1.2 Pit filling’ for more information on the fill process.

GEOGRID_LDASOUT_Spatial_Metadata.nc - This is a CF-netCDF format file that provides the

spatial metadata associated with the GEOGRID variables. By default, no 2-dimensional
grids are written to the file. This file is used for appending geospatial metadata to the
land surface model output, if necessary.

GWABASINS.nc - This is a 2D netCDF of the ‘basn_msk’ grid, but regridded to the GEOGRID file

resolution. NoData cells are given a value of ‘-9999’. This file is created using the
‘FullDom LINKID local basins’ default method of defining groundwater basins. See ‘7.3
Build Groundwater Bucket Parameter Table (GWBUCKPARM) and Grid (GWBASINS)‘ for
more information.

LAKEPARM.nc — Lake parameter table. This netCDF format file is created if the option to create

the lake parameter file is TRUE (checked) and a lake shapefile is provided. The table will
contain a record for each lake feature in the Fulldom_hires.nc ‘LAKEGRID’ variable, and
contain derived and default parameters for each lake. See ‘8.4 Lake/Reservoir
incorporation and routing’ for more information on how the lake parameter table is
created.

Route_Link.nc — The reach-based routing parameter file. This netCDF format file is created if

the ‘Create reach-based routing (RoutelLink) files?’ parameter is TRUE (checked). The file
contains a record for each stream segment. The stream segments in this table are also
identified by the unique ‘LINKID’ values in the ‘LINKID’ variable in the ‘Fulldom_hires.nc’
file, and values in the ‘ARCID’ field of the output ‘streams.shp’ shapefile. This table
contains derived and default stream segment parameters that are calculated based on
the vector stream network and topology in the ‘streams.shp’ shapefile. For more
information see ‘8.3 Reach-Based Routing’.

Streams.* - Streams shapefile. Shapefiles are a collection of files with the same name but

different extensions. Together these files make up the shapefile. The ‘streams.shp’
shapefile has one feature for each stream segment in the domain. This file is meant to
accompany the ‘Route_Link.nc’ file and Fulldom_hires.nc ‘LINKID’ variable. The ‘streams’
shapefile is only created when the option ‘Create reach-based routing files?’ is TRUE
(checked). The ‘ARCID’ field is the unique identifier for each stream segment, and
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corresponds to the ‘link’ variable of the ‘Route_Link.nc’ file and the ‘LINKID’ variable in

the ‘Fulldom_hires.nc’ file. The geometry of the stream segments in this shapefile

informs many of the parameters in the ‘Route_Link.nc’ file.

File Name Variable Name Data Type Default Value NoData
Fulldom_hires.nc CHANNELGRID Integer - -9999
Fulldom_hires.nc FLOWACC Float - -
Fulldom_hires.nc FLOWDIRECTION Integer - 255
Fulldom_hires.nc frxst_pts Integer - -9999
Fulldom_hires.nc basn_msk Integer - -9999
GWBASINS.nc BASIN Integer - -9999
Fulldom_hires.nc LAKEGRID Integer - -9999
Fulldom_hires.nc landuse Float - -
Fulldom_hires.nc LATITUDE Float - -
Fulldom_hires.nc LINKID Integer -

Fulldom_hires.nc LONGITUDE Float - -
Fulldom_hires.nc OVROUGHRTFAC  Float 1.0 -
Fulldom_hires.nc RETDEPRTFAC Float 1.0 -
Fulldom_hires.nc STREAMORDER Integer - -15
Fulldom_hires.nc TOPOGRAPHY Float - -9999

Table 5. Output grids and data types from Process GEOGRID File tool.

6.2 LogFile

Alogfileis initiated using the filename provided to the ‘Output ZIP File’ parameter of the pre-processing

tool. This log file collects all messages provided by the tool during execution and writes them to an ASCII

file in the same directory as the output Zip archive, with the “.log’ extension appended to the archive

filename. If the tool fails to execute successfully, however, the log file will be created but nothing will

be written. In this case, consult the geoprocessing ‘Results’ tab in ArcMap or ArcCatalog for more

information (Figure 10).
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Results ® X [F]
- B Current Session A
= 5 Export grid from GEOGRID file [122628_03232018] 2
## Output Raster: geo_em_ExportGrid 1.tif @
# ¢ Inputs
+ [ Environments
SI8 Messages >
(L Executing: ExportGrid C\Data\Projects\Gochis\Test_Cases\Croton_TestCase\geo_em.nc HGT_M C}\ %
(1] Start Time: Fri Mar 23 12:26:24 2018 %
(i) Running script ExportGrid... 2

0] Step 1. NetCDF Conversion initiated... (HGT_M)

L Map Projection: Lambert Conformal Conic

Using MOAD_CEN_LAT for latitude of origin.

Using Standard Parallel 2 in Lambert Conformal Conic map projection.

GeoTransform: 1841999.59153 1000.0 0 437000.820507 0 -1000.0

Step 1 completed without errar.

Process completed without error.

Output Raster: C\Data\Projects\Gochis\Test_Cases\Croton_TestCase\geo_em_ExportGrid1.tif
(1) Completed script ExportGrid...

(i Succeeded at Fri Mar 23 12:26:28 2018 (Elapsed Time: 3.40 seconds)

e [ e | e ....'+-

Figure 10. Messages returned by the ‘Export grid from GEOGRID file’ tool as viewed in the ‘Results’
tab of ArcMap.

6.3 How to use the WRF-Hydro ‘routing stack’ files

The output files from the WRF-Hydro GIS pre-processing tool are intended to a) produce the required
set of routing grids necessary to run WRF-Hydro, and b) assist in the GIS processing, visualization, and
analysis of data related to the WRF-Hydro configuration. Thus, the output ZIP archive from ‘Process
GEOGRID File’ contains files that will compose the final ‘routing stack’ as well as additional data. It is
here that the user may substitute any custom grids they have into these netCDF files. See ‘6.3.1 Using
alternate grids in WRF-Hydro ’ for more information on this option.

The output ZIP file must be extracted to a location on disk, and the relevant netCDF files will be placed
in the \RUN or \DOMAIN directories with respect to the WRF-Hydro directory structure. The input
GEOGRID file will also need to be placed in the \DOMAIN directory. Paths to these files must be updated
in the ‘hydro.namelist’ and ‘namelist.hrldas’ model nameslists.

6.3.1 Using alternate grids in WRF-Hydro

The ‘Process GEOGRID File’ tool will create all of the necessary grids for running WRF-Hydro.
There may be instances, however, when a user wishes to use an alternate grid. An example is
provided for using a spatially varying ‘OVROUGHRTFAC’ grid. Rather than using the static, single-
value version of the ‘OVROUGHRTFAC’ grid given by default in the ‘Process GEOGRID File’ tooal,
the user may wish to use a spatially-varying grid. If the desired grid is formatted to have the
same dimensions, extent, and cellsize as the routing grid, it may be used as long as it has the
same variable name and dimensions as the corresponding grid that is being replaced. Simply
substitute the replacement grid using netCDF tools such as ‘ncks’.
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Note: replacement of certain grids may affect the model behavior. For example, substituting the
GEOGRID ‘landuse’ or ‘landmask’ variable will affect model behavior if the ‘topography’ variable
does not respect the new layers. For example, the model may produce erroneous results or fail
to run if there is no elevation gradient (or a negative slope) between areas classified as ‘land’
and ‘ocean’. Be sure that areas with valid elevation values correspond only with ‘land’ grid cells
from the coarse grid ‘LANDMASK’ variable in the GEOGRID file. This must be done because the
model cannot route water through areas classified as ocean in the LANDMASK.

6.4 How to visualize WRF-Hydro ‘routing stack’ files in GIS applications

The output files from the WRF-Hydro GIS pre-processing tool may be viewed in standard GIS
applications such as ArcGIS and QGIS. As of this version (v5.0), the vast majority of WRF-Hydro input
and output files are CF-compliant, and as such may be viewed with a variety of visualization

applications. For more information on the standards, see Section 4.6. Climate and Forecast Conventions

(CF) metadata. For convenience, some data is saved to the output ‘routing stack’ ZIP file in shapefile

format, such as the streams.shp and lakes.shp. These are shapefiles and may be viewed using the data

import functionality within any GIS application. A description is given below for accessing netCDF data

in the Esri® ArcMap application.

6.4.1

Visualizing and accessing netCDF data in ArcGIS

The WPS GEOGRID file does not contain standardized spatial metadata, and thus can only be
viewed in ArcGIS without a defined coordinate system, making overlays with other spatial data
impossible. In order to view a WPS GEOGRID variable as a georeferenced raster dataset, use the
“Export grid from GEOGRID file” tool. For more information, see Section 7.8 Exporting a grid
raster from a GEOGRID variable.

The 2-dimensional netCDF files (Fulldom_hires.nc, GWBASINS.nc) may be viewed by either
dragging and dropping the file into the ArcMap table of contents, or using the Multidimension
Tools > Make NetCDF Raster Layer tool. Using the “Make NetCDF Raster Layer” tool, specify the
variable to view, and select “x” and “y” as the “X Dimension” and “Y Dimension” parameters,
respectively. Name the temporary raster layer in the “Output Raster Layer” parameter. See
Figure 11 for an example.

Point time-series CF-netCDF format files (Route_Link.nc, LAKEPARM.nc) may be viewed as a
point feature layer using the Multidimension Tools > Make NetCDF Feature Layer tool. This tool
requires a list of variables along the station dimension (“feature_id”) and the specification of
“lat” and “lon” as the “X Dimension” and “Y Dimension” variables, respectively. Importantly, the
“Row Dimension” must be the station dimension (“feature_id”). The temporary feature layer
will be given the name provided in the “Output Feature Layer” parameter. See Figure 12 for
more information.
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All netCDF format files may be viewed as a table using the Multidimension Tools > Make
NetCDF Table View tool. This includes the GWBUCKPARM.nc file, which is a groundwater
parameter table and contains no spatial referencing information.

#. Make NetCDF Raster Layer — O X

Input netCDF File

| C:\Users\ksampson'\Desktop\Tool_v5\Results\Test_10_3_1_3\Fulldom_hires.nc | E-
Variable

| CHANNELGRID ~]
X Dimension

< v]
¥ Dimension

v v]

Output Raster Layer
| CHANNELGRID_Lyr |

Band Dimension (optional)

Dimension Values (optional)
Dimension Value o
»

Figure 11. Make NetCDF Raster Layer tool dialog for viewing Fulldom_hires.nc files.

"r-\\ Make NetCDF Feature Layer — O X

Input netCDF File ~
|C:\Users\ksampson\Desktop‘\TooI_vS\ResuIts\FuII_DeaI 10_3_1\Route_Link.nc | @

Variables

| ~ |

link +
to
lon x
lat

alt
order
Length
So
gages

X Variable
| lon v|

Y Variable
| lat v|

Output Feature Layer
| link_Layer |

Row Dimensions (optional)

| ~ |

‘ feature_id ‘ + Vv

Figure 12. The ArcGIS Make NetCDF Feature Layer tool used to view the Route_Link.nc file as points.



7 Other utilities

In addition to the main ‘Process GEOGRID File’ script, other script tools are provided in the ‘Utilities’
toolset (Figure 13) of the WRF-Hydro GIS pre-processing toolbox. Below is a description of each utility.

= Ep GEOGRID_STANDALONE.pyt
= & Processing

& Process GEOGRID File

= & Utilities
& Add Lake Parameters
& Add reach-based routing
%' Build Groundwater Inputs
%' Build Spatial Metadata File
% Create Domain Boundary Shapefile
& Examine Outputs of GIS Preprocessor
5 Export ESRI projection file (PRJ) from GEOGRID file
5 Export grid from GEOGRID file
& Generate Latitude and Longitude Rasters
% Raster Grid to FullDom format

Figure 13. Utilities toolset as viewed from ArcCatalog.

7.1 Add Lake Parameters

The ‘Add Lake Parameters’ tool will add the lake parameters to an existing routing stack ZIP file. The
user will submit an existing routing stack ZIP file, a lakes polygon shapefile or feature class, and an
output ZIP file in which to store the new routing stack. The LAKEGRID variable will be updated to
include lakes, the CHANNELGRID variable will also be masked to the lakes in LAKEGRID, the
LAKEPARM.nc lake routing table will be created, and the lake shapefile will be saved to the output ZIP
archive. See ‘8.4 Lake/Reservoir incorporation and routing’ for more information on this process.

7.2 Add reach-based routing

The ‘Add reach-based routing’ tool will add reach-based routing parameters to an existing routing
stack ZIP file. No inputs are necessary other than the input routing stack ZIP file and the output
routing stack ZIP file. The ‘CHANNELGRID’ variable is used to define the stream network. A LINKID
variable is added to the FullDom_hires.nc file, a streams.shp polyline shapefile is also added to the
output, as is the reach-based routing parameter table (Route_Link.nc) in netCDF format. See ‘8.3
Reach-Based Routing’ for more information on this process.

7.3 Build Groundwater Bucket Parameter Table (GWBUCKPARM) and Grid (GWBASINS)

The ‘Build Groundwater Inputs’ tool is a general utility for creating a parameter table of groundwater
buckets used in the groundwater scheme in WRF-Hydro. The groundwater buckets must be resolved
on the coarse LSM grid (the grid defined by the GEOGRID file). The outputs of this tool are a 2D
groundwater bucket grid (GWBASINS.nc), and a parameter table in netCDF format.

The tool requires the Fulldom_hires.nc netCDF file, as well as the associated GEOGRID file to define the
LSM and routing grids. A method must be selected from the ‘Method for deriving groundwater basins’
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drop-down menu. The output of this tool will include a ‘GWBASINS.nc’ and ‘GWBUCKPARM.nc’ netCDF
files, the older-format ASCII equivalents, or both depending on the ‘Output table type’ option selected.

For more information, see ‘8.5 Groundwater Parameters’

7.4 Build Spatial Metadata File

The ‘Build Spatial Metadata File’ tool will create netCDF format spatial metadata files from the
GEOGRID file (for LDASOUT output) and the FullDom_hires.nc routing grid file. These spatial metadata
files contain CF-compliant georeference information for the grids, as well as some additional
metadata that assists GIS applications like ArcGIS and QGIS/GDAL to interpret the projection and
datum associated with each grid. These files are produced by default by the ‘Process GEOGRID File’
tool, but users may desire to create CF-compliant metadata from an existing routing stack or
GEOGRID file. WRF-Hydro v5 can use this spatial metadata and append it to output files in order to
make WRF-Hydro output CF-compliant. This is useful for visualizing the output in GIS.

For more information on Climate and Forecast (CF) Conventions, see http://cfconventions.org/

7.5 Create a Domain Boundary Shapefile

The ‘Create Domain Boundary Shapefile’ utility will create a simple single-feature polygon shapefile
using the GEOGRID file as input (required). The extent of the grid is determined from the grid
dimensions, cellsize, and georeferencing information in the global attributes of the GEOGRID. A polygon
is generated using the GEOGRID CRS. The geometry is saved to shapefile format. This shapefile may be
used, for example, to display the boundary of a WRF domain on a map (Figure 14).
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Figure 14. Polygon (red) representing the extent of a WRF domain.
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7.6 Examine the Outputs of the WRF-Hydro GIS Pre-processor

The ‘Examine Outputs of GIS Preprocessor’ utility script extracts the individual datasets from the ZIP
archive created by ‘Process GEOGRID File’ and converts those files to formats that are easily consumed
by a Desktop GIS. Each 2D variable in a netCDF file in the output ZIP archive will be converted to a GRID
format raster. Additional layers, such as shapefiles and single-dimension netCDF files will be
uncompressed. The ‘Input ZIP File’ parameter requires the ZIP archive that is created by the ‘Process
GEOGRID File’ tool. The ‘Output Folder’ parameter is required and should be the name and location of
a folder on disk that does not yet exist. The tool will create the folder, de-compress the archive, and
save converted grids to this location. See Figure 15. Dialog box for the ‘Examine Outputs of GIS
Preprocessor’ utility..

]

<~ Examine Outputs of GIS Preprocessor — =

¥ Input ZIP File Examine Outputs of GIS Preprocessor

=]
This tool takes the output zip file from the

" ProcessGeogrid scriptand creates a raster from
each output NetCDF file. The Input should be
a zip file that was created using the WRF Hydro
pre-processing tools. The Output Folder
parameter should be set to a non-existent folder
location. The tool will create the folder which will
contain the results.

Cancel Enviranments. .. << Hide Help Tool Help

¥ Output Folder

Figure 15. Dialog box for the ‘Examine Outputs of GIS Preprocessor’ utility.

7.7 Creating a projection definition file from GEOGRID

The ‘Export ESRI projection file (PRJ) from GEOGRID file’ tool takes the WRF GEOGRID file as input
(required) and automatically determines the projection based on the global attribute data to produce
a .prj projection file. The file is simply an ASCII file containing the text that describes the coordinate
reference system parameters. This file allows the user to build data and grids in the projection of the
WRF domain using standard GIS applications. The projection information is based on the domain
defined by a WPS-generated GEOGRID file. See the following link for more information on the Esri® PRJ
format:

http://vsp.pnnl.gov/help/Vsample/ESRI PRJ File.htm

See ‘4.1 Coordinate Systems’ for more information on how the projection definition is acquired from
the GEOGRID file.

7.8 Exporting a grid raster from a GEOGRID variable

The ‘Export grid from GEOGRID file’ utility takes as input a WPS GEOGRID file (required), and saves it to
a raster format. This tool allows the user to quickly plot any Mass grid variable in a GIS, with proper
georeferencing. Once a valid GEOGRID file is input, internal tool validation is performed to gather a list
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of all variables on the Mass grid (: stagger = ‘M’) from the GEOGRID netCDF file. The user must select
one of the variables from the ‘Variable Name’ drop-down menu (Figure 16). The tool automatically
determines the domain projection based on attribute data within the GEOGRID file. See ‘4.1 Coordinate
Systems’ for more information on georeferencing a GEOGRID file. The required ‘Output Raster’ may be
any format of raster supported by ArcGlIS.

< Export grid from GEOGRID file - 0

Input GEOGRID File Variable Name

C:\Users'\ksampson\Desktop\GPP_Testing!\Standalone_Test_Data'Front_Range_CO_Lambert\Front E;-

¥ Variable Name Mo description available

£

HLAT_M
XLONG_M
CLAT
CLONG
MAPFAC_M
MAPFAC_MX
MAPFAC_MY
E

F

SINALPHA P Tool Help
COSALPHA
LANDMASK, e
LANDUSEF

LU_INDE¥

CON

VAR

0Al

0A2

0A3

0A4

oLt

oL2

oL3

oL4

HGT_M

SLPY

SLPY

SOILTEMP

SOILCTOP

SOILCBOT i

>

Figure 16. Dialog box for the "Export grid from GEOGRID file’ utility.

7.9 Generating the Latitude and Longitude Rasters

The “Generate Latitude and Longitude Rasters” tool is a general utility for creating a grid of latitude and
longitude values. This function is necessary for WRF-Hydro, but is a deprecated function in ArcGlIS. This
process uses the ArcGIS 9.3 python module ‘arcgisscripting’, which is available through backward
compatibility from the ‘arcpy’ module. The tool takes any raster as input, with a valid coordinate system
defined, and produces as output the ‘latitude’ and ‘longitude’ Esri® GRID rasters in the output directory.
The required ‘Output Folder’ parameter is a directory that must exist on disk.

8 GIS Methods Descriptions

Many GIS methods are used in the WRF-Hydro GIS pre-processing tools. A description of some of the
more important methodological choices is given below.

8.1 Terrain Processing

The workflow and methods used in processing the terrain data are largely borrowed from the early
portions of the Basic Dendritic Terrain  Processing  workflows of  ArcHydro
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(http://downloads.esri.com/archydro/archydro/Tutorial/Doc/Arc%20Hydro%20GP%20T00ls%202.0%

20-%20Tutorial.pdf, page 47). These processes occur in the wrf_hydro_functions.py file, in the

‘sa_functions’ function.

8.1.1

8.1.2

8.1.3

Resampling Method

The input elevation data will typically require regridding and/or reprojection to the destination
grid (routing grid). A resampling method is required, and in v5 this method has been changed
to ‘BILINEAR’ from ‘NEAREST’ (nearest-neighbor). The default resampling method can be
altered by changing the global variable ‘ElevResampleMethod’ in the header of
‘wrf_hydro_functions.py’. Other acceptable values ‘CUBIC’ and ‘MAJORITY’, although the
majority method is typically best suited to discreet data. For more on resampling, see:

http://desktop.arcgis.com/en/arcmap/latest/extensions/spatial-analyst/performing-

analysis/cell-size-and-resampling-in-analysis.htm

Note: The elevation data is converted to floating point values if the provided data is integer.

Pit filling

The regridded elevation data must be pit-filled, which is a process to remove depressions. The
elevation of the area of any topographic depression is increased until each depression fills. See
6.1 Description of output files (TOPOGRAPHY) for more information.

Note: It may occur that the elevation resampling process will introduce pits. In some landscapes,
filling these pits will cause large areas upstream of the pit to ‘fill’, or have the elevation raised
to the level that eliminates the depression. This is noticeable because the output steam channels
behave as they would in lakes or in areas of extremely low relief. Manual stream-burning
methods may be required on the input elevation data before processing.

The ‘z_limit" global variable in the wrf_hydro_functions.py script can be used to control the
maximum fill depth from the pit-filling process. This value is set to 1000.0m by default.

NoData assignment

WRF-Hydro requires NoData values in grids to be specified by a value of -9999’. However, GIS
applications allow NoData in gridded datasets. Throughout the workflow, NoData is frequently
converted to -9999 before writing WRF-Hydro input files.

8.2 Station-based watershed delineation

If the user provides a CSV file with gage locations as input to the ‘Forecast Points (CSV)’ parameter in

the ‘Process GEOGRID File’ tool, additional processing is performed to delineate basins based on those

points. For more on the format of the CSV file, see ‘5.4.2 Forecast points (CSV) (optional)’, above. The

‘sa_functions’ function in the ‘wrf_hydro_functions.py’ script will handle the delineations. The input
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CSV file is used as input to the ‘MakeXYEventLayer’ function, and fields ‘LAT’ and ‘LON’ are used to
define the geodetic coordinates (in WGS84). These points are snapped to the nearest grid cell center.
Iteration may be required to make sure that station gage locations will coincide with channel elements.
S ‘9.1 Manual Specification of Station Points’ for a description of how to ensure that station points will
be delineated properly.

The ‘“frxst_pts’ ‘Fulldom_hires.nc’ file variable will contain a grid with gage locations snapped to the
nearest grid cell. The tolerance of this snapping is 1 grid cell by default. The basins delineated from the
gage locations must be ‘walked’ downstream by a certain distance to ensure the resulting basin
contains the gage location. Thus, the gage locations are snapped again to the flow accumulation grid,
but this time with a tolerance of 3x the resolution of the routing grid. This tolerance can be controlled
via the ‘walker’ global variable in the ‘wrf_hydro_functions.py’ script. Basins in ‘basn_msk’ variable are
delineated from this downstream location (see Figure 17).

If the ‘Mask CHANNELGRID variable to forecast basins?’ parameter is TRUE (checked), the ‘basn_msk’
grid will be used to mask channels to these basins, such that channel cells inside the delineated basins
will equal ‘0’ (active) and channel cells outside of these basins are given a value of ‘-1’ (inactive).

\' J

e e

Figure 17. Gage point (yellow circle) given by in the gage CSV file, the corresponding gage location grid
cell (green square), and the resulting watershed (shaded red).

8.3 Reach-Based Routing

The efficiency of routing of runoff may be significantly improved by performing a reach-based routing
approach. This is facilitated through building a table of stream segment attributes on which to perform
the routing. This process is only executed if the ‘Create reach-based routing (Routelink) files?’ option
to the ‘Process GEOGRID File’ tool is TRUE (checked). Within the ‘sa_functions’ function, a separate
function called ‘Routing _Table’ is called which performs the vectorization and prepares the
Route_Link.nc file. This section provides information on the process of building this parameter file.
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8.3.1 Vectorizing the stream network and describing connectivity

The Spatial Analyst > Hydrology > Stream to Feature tool converts gridded channel information
(CHANNELGRID) to vector-based stream segments. Each segment is given a unique identification
(ARCID), and a basic network topology is defined in the form of a segment based topology (to:from)
based on ARCID (Figure 19). For more on how this process is performed in ArcGIS, see:

http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/stream-to-feature.htm

The vector-based stream segments by default extend to the edge of the domain. A simple process is
used to find and trim all segments such that the lines terminate at the cell center of grid cells along the
outer edge of the domain.

8.3.2 Route Link.nc reach-based routing table

The Route_Link.nc file describes spatial and non-spatial characteristics of each river reach. The ‘link’
variable in this table corresponds to the ‘ARCID’ field in the ‘streams.shp’ shapefile. To visualize any of
the attributes in this table on a map, simply join the streams shapefile to this table using the ‘link’ and
‘ARCID’ fields, respectively. Converting the ‘Route_Link.nc’ table to an ArcGIS readable table requires
using ‘Make NetCDF Table View’ tool in the Multidimension Tools toolbox. Alternatively, the ‘Make
NetCDF Feature Layer’ tool may be used to plot the points using the ‘lon” and ‘lat’ variables as the ‘X
Variable’ and ‘Y Variable’, respectively, and dimensions and ‘feature_id’ as the ‘Row Dimension’. See
Figure 18. Make NetCDF Feature Layer tool in ArcGIS, configured for plotting Route_Link.nc file
variables in 2D.for an example.

-

Make NetCDF Feature Layer - O X
Input netCDF File ) Input netCDF File
| C:\Data\Projects\Test_Cases\Route_Link.nc ‘ E
Variables The input netCDF file

*]
link Al
from
to x
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lat
alt
order
Length
So h

< >
X Variable

lon v|
Y Variable
| lat v|
Output Feature Layer
| link_Layer1 |
Row Dimensions (optional)

v
feature_id +

x WV

< >
oK Cancel Environments... << Hide Help Tool Help
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Figure 18. Make NetCDF Feature Layer tool in ArcGIS, configured for plotting Route_Link.nc file
variables in 2D.

Many of the fields in this table are given default attributes, which may be changed in the global
attributes section of the ‘wrf_hydro_functions.py’ file. Other attributes are calculated from the stream
segment geometry (for example ‘length’), or a combination of geometry and topographic attributes (for
example ‘slope’).

Note: The order of records in this table is extremely important. The segments must be ordered such
that no segment is entered before all contributing segments are entered. A topological sorting is
performed (‘sort_topologically_stackless’ function nested in the ‘Routing Table’ function of
‘wrf_hydro_functions.py’ script) that begins with all order 1 streams and continues to add elements to
the table until all downstream segments are entered.

Note: The ‘from’ variable in Route_Link.nc is now set to 0 and is unused by WRF-Hydro.

Link: 15206
From:
To: 15207

Link: 15295
From: 15207
To: 15482

Link: 15207
From: 15266
To: 15295

Link: 15266
From:
To: 16207

Figure 19. Example of simple network topology in reach-based routing.

36



Variable Parameter name Field type Default value
link Link ID Integer -
from From Link ID (not used) Integer 0

to To Link ID Integer -

lon Start node longitude Float -

lat Start node latitude Float -

alt Start node elevation (m) Float -
order Stream order (Strahler) Integer -

Qi Initial Flow in Link (cms) Float 0
MusK Muskingum routing time (s) Float 3600
MusX Muskingum weighting coefficient Float 0.2
Length Stream length (m) Float -

n Manning’s roughness Float 0.035
So Slope (%; drop/length) Float -
ChSlp Channel side slope (%; drop/length) Float 0.05
BtmWdth Bottom width of channel (m) Float 5
time Time of measurement (not used) Float -
Kchan Channel conductivity (mm/hr) Integer 0
gages Gage ID Character ! !

* See definition of orifice and lake elevations, above.

Table 6. Variable definitions for the Route_Link.nc reach-based routing table.

8.3.3 Gages on the reach-based network

If reach-based routing is requested in conjunction with forecast points, the forecast points are

associated with the reach based on the LINKID cell value that corresponds to each forecast point. The

‘gages’ variable in the Route_Link.nc file is updated with the ID of the forecast point. If more than one

forecast point is associated with one reach, the forecast point is chosen based on rank in the forecast

point CSV file.

8.4 Lake/Reservoir incorporation and routing

When the optional Boolean ‘Create lake parameter (LAKEPARM) file?’ parameter is TRUE (checked)
and a lakes shapefile is provided to the Process GEOGRID File tool, then several layers are altered to

take reservoir routing into account.

Lake processing is performed in the ‘add_reservoirs’ function in the ‘wrf_hydro_functions.py’ script.
The global variable ‘LK_walker’ may be altered to produce desired results. This variable gives the
distance (in number of pixel-widths) downstream of each lake to travel in order to determine the

minimum elevation value of the lake (altitude of the lake bottom).

Note: The lake features in the input shapefile are renumbered from 1 to n by this tool.
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Note: The input lakes shapefile is clipped to the extent of the GEOGRID file. This means that any lakes
that cross the edge of the domain will be clipped and only the area inside the model domain will be
calculated.

The lake polygons are rasterized according to the “MAXIMUM_AREA” algorithm in order to create the
‘LAKEGRID’ variable. Each lake outlet is identified using the largest flow accumulation value (from the
flow accumulation grid, ‘FLOWACC’) within the gridded lake. The CHANNELGRID pixel at the location
of maximum flow accumulation is altered to reflect the ID of the lake, defining that cell as the lake
outlet. All channel elements within the lake are eliminated in order to avoid channel routing within
the lake area. The lake minimum elevation is gathered from a location downstream of the lake outlet,
with the distance given by the number of pixels in the ‘LK_walker’ global variable. For example, a
routing grid resolution of 100m and threshold of 3 yields a snapping tolerance of 300m downstream
of the lake outlet.

Zonal Statistics is performed on the altered lake polygons to calculate maximum lake elevation. The
‘TOPOGRAPHY’ layer is used to gather elevation, while area and lake centroid are calculated directly
from the polygon geometry. For more information on Zonal Statistics, see:

http://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/zonal-statistics.htm

The orifice elevation and initial fractional water depth are calculated based on the minimum and
maximum lake elevations, defined above. A fraction is applied to of the elevation range, as defined
below:

1) The Orifice elevation is the minimum lake elevation plus 1/3 of the vertical distance
between the lake minimum and maximum elevations.

2) The initial fractional lake depth is set to 0.90 (90% full), which is equal to 9/10 of the
vertical distance between the lake minimum and maximum elevations.

Note: Occasionally there will be no elevation variation within the lake polygon. If this is the case, the
lake will be assigned a default depth of 1.0m, which can be altered based on the global ‘minDepth’
variable in wrf_hydro_funtions.py.

The calculated lake parameters are written to the ‘LAKEPARM.nc’ file (Table 7). The ‘lake_id’ variable
contains each lake identifier, and corresponds to the grid cell values in the LAKEGRID variable in
‘Fulldom_hires.nc’. The CHANNELGRID variable in ‘Fulldom_hires.nc’ is also altered so that the lake
outlet pixel contains the lake identifier. This is the point where lake outflow is placed back into the
channel network. Default lake routing parameters (OrificeC, OrificeA, WeirC, WeirL) can be altered in
the global variables of the ‘wrf_hydro_functions.py’ script.

Note: Lakes do not currently work in the reach-based routing scheme.
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Variable Parameter name Field type Default value

lake_id Lake ID Integer -
LkArea Lake area (km?) Double -
LkMxE Maximum lake elevation (m ASL) Double -
WeirC Weir Coefficient Double 0.4
Weirl Weir Length (m) Double 10.0
WeirE Weir elevation (m ASL) Double

OrificeC Orifice Coefficient Double 0.1
OrificeA Orifice Cross-sectional area (m?) Double 1.0
OrificeE Orifice Elevation (m ASL)* Double -
lat Centroid latitude (WGS84) Float -
lon Centroid longitude (WGS84) Float -
ifd Initial fraction water depth* Float 0.90
time Time of measurement Double

Discharge Default Discharge (CMS) Double
ascendingindex Index to use for sorting IDs Integer

* See definition of orifice elevation and initial fill depth, above.

Table 7. Parameter definitions for the LAKEPARM.nc lake parameter file.

Figure 20. Lake/Reservoir routing grid example. CHANNELGRID layer contains channels in blue and
lake outlet in pink, the LAKEGRID layer shows a lake in green. The lake outline from the input lake
shapefile is outlined in black.



8.5 Groundwater Parameters

Groundwater buckets are now automatically generated with any WRF-Hydro routing stack, such that
the groundwater module may be activated during a WRF-Hydro run. Although these inputs may be
generated in many different ways (see below), the default method is ‘FullDom LINKID local basins’.
This may be changed by altering the ‘defaultGWmethod’ and ‘in_GWPolys’ global variables in the
GEOGRID_STANDALONE.pyt python toolbox script.

The most common methods for generating the 2D groundwater inputs may be to delineate above
known forecast points, generating contributing basins for each reach in a river segment in a network,
or using existing polygon geometries that define the spatial extent of groundwater basins. No matter
which method is employed, the groundwater buckets must be resolved on the coarse LSM grid (the
grid defined by the GEOGRID file).

Methods to define groundwater basins:

e ‘FullDom basn_msk variable” will use the ‘basn_msk’ variable in the ‘Fulldom_hires.nc’ file, as
long as the ‘Process GEOGRID file’ tool was run using forecast locations. The basins are
resampled to the coarse LSM grid.

e ‘FullDom LINKID local basins’ will generate contributing basins for each reach in the
CHANNELGRID network, based on derived LINKID. This may be selected regardless of whether
or not reach-based routing outputs were generated. The CHANNELGRID network will be used to
build a network of LINKIDs using the ‘Spatial Analyst Stream to Features’ tool. Contributing
basins are generated for each unique LINKID value using the Spatial Analyst ‘Watershed’ tool,
then resampled to the coarse LSM grid.

e ‘Polygon Shapefile or Feature Class’ allows the user to provide a shapefile or feature class of
groundwater basins. Individual polygons are rasterized, resolving those basins on the coarse
LSM grid.

Once the 2D groundwater basins are resolved on the coarse LSM grid resolution, the parameter table
(GWBUCKPARM.Nc) is generated using the gridded area for each groundwater basin and a variety of
default bucket parameters (Table 8. Parameter definitions for the GWBUCKPARM.nc groundwater
bucket parameter file.).

Variable Parameter name Field type Default value
Basin Basin monotonic ID (1...n) Integer -

Coeff Coefficient Float 1.0
Expon Exponent Float 3.0
Zmax Maximum depth (m) Float 50.0
Zinit Initial depth (m) Float 10.0
Area_sqgkm Basin area (km?) Float -
ComlID Catchment Gridcode Integer -

Table 8. Parameter definitions for the GWBUCKPARM.nc groundwater bucket parameter file.
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For more information, see ‘7.3 Build Groundwater Bucket Parameter Table (GWBUCKPARM) and Grid
(GWBASINS)'.

9 Miiscellaneous Topics in the Use of the WRF-Hydro pre-processor

9.1 Manual Specification of Station Points

This section describes the steps needed to improve the ‘snapping’ of station points to the
derived channel grid. Because of inaccuracies in the spatial location information of station data
and digital elevation models and because of small errors introduced when projecting geospatial
data from one coordinate system to another, the situation occasionally occurs where
streamflow observation/gauging points specified in the station .csv file do not get properly
assigned to the desired location on the channel network. The result of this error is the
generation of erroneous basins or watersheds and erroneous extraction of flow values from the
WRF-Hydro channel routing components. Because these errors are often random, or non-
systematic, there is no generalizable way to automate the correction procedure with a high
degree of fidelity and manual manipulation or specification of the data is often required. This
situation is very common in hydrographic data processing and well known to hydrologists. The
approach presented here to deal with this issue seeks to present a relatively simple way to
determine the correct locations of the stations for the channel network that is created from the
WREF-Hydro pre-processing tools.

The steps to improve the assignment of station locations in ArcGIS are as follows:

1. Import the original .csv station file using the File > Add Data > Add XY Data drop-down menu.
Upon ingest, be sure to define the projection as Geographic WGS84. Remember that the
coordinates of your station points should be in WGS84. Export the imported data layer as a
shapefile by right-clicking on the event layer and selecting > Data > Export Data.

2. Assuming you have already executed the pre-processing tool once with a user-specified set
of observation points in CSV format and successfully created a ZIP file with the netCDF data
variables, you’ll need to extract the topography (variable ‘TOPOGRAPHY’), basin mask
(variable ‘basn_msk’) and channel network (variable ‘CHANNELGRID’) from the
‘Fulldom_hires.nc’ file. VERY IMPORTANT: Users can also use the ‘Examine Outputs of GIS
Preprocessor’ utility script described above to automatically convert netCDF variables to
GRID raster format.

3. Import these netCDF variables from the Fulldom_hires.nc file into ArcGIS using the
Multidimension > Make NetCDF Raster Layer tool. The default projection will be the same
as that in the GEOGRID file. VERY IMPORTANT: Users can also use the ‘Examine Outputs of
GIS Preprocessor’ utility script described above to automatically convert all netCDF variables
to GRID raster format.

Add the station point shapefile to the map that was created in step #1 above.
5. Open a copy of the original .csv station file in Notepad or your preferred spreadsheet editor.
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6. In ArcMap, zoom into each station’s location that you need to modify. If not already set,
you’ll need to set the displayed coordinates (i.e. the location information in the lower right-
hand corner of the ArcGIS map window) to ‘Decimal Degrees’ [This can be done by right-
clicking on the ‘Layers’ icon in the ArcGIS Table of Contents window and navigating as
follows: Properties > General > Units: Display > Decimal Degrees]. As you zoom into your
‘problem’ station location you’ll likely notice that the station is not on the channel network
where you wish it to be.

7. Panyour cursor over the exact location of where you want the station to be on the derived
channel network. Again, due to subtle errors associated with projection of geospatial data
this new location may not be the exact location your original data specified your station to
be. You will need to make sure the station location is in the correct location on the derived
channel network. Once you have determined that location, insert those exact coordinates
into the LAT and LON fields of the .csv file you have open for editing. An easy way to get
these coordinates is to use the ‘Identify’ cursor option in ArcGIS which provides coordinate
information when you click on any point. Simply click on the cell where you desire to place
the station, then select ‘copy’, and paste the latitude and longitude coordinates from the
‘Location’ field in the ‘Identify’ window into your new .csv file. You will then use this new
CSV file when you re-run the WRF-Hydro GIS Pre-processing tool.

8. Repeat this search-edit process for each station in question.

9. When you have finished editing the station points, close all data layers in the current ArcGIS
session and save your newly edited CSV station file.

10. Re-run the WRF-Hydro GIS Pre-processing tool exactly as specified above EXCEPT make sure
you use the new, modified CSV station file whose LAT/LON locations have been edited to
match the desired locations on the derived channel network. The new set of data layers
created should produce the station forecast points and watersheds that are desired. If not,
you’ll need to inspect the locations again more closely and make further adjustments as
necessary.

10 Script Customization

Simple script changes include altering the global variables in the headers of both
‘wrf_hydro_functions.py’ and ‘GEOGRID_STANDALONE.pyt’ files. The default file names, variable
values, interpolation and transformation methods, and other control switches are exposed as global
variables. These can be altered to produce many desired outputs. If a change is made, save the file and
refresh the Python Toolbox (right-click > Refresh) before running the tool.

Users may have certain customizations that they would like to add into the WRF-Hydro GIS pre-
processing workflow. A thorough understanding of Python and the ArcGIS API for Python (arcpy) will
be useful. The following notes may also assist users in customizing the scripts. For more information on
authoring Python Toolboxes in ArcGlIS, see:
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http://desktop.arcgis.com/en/arcmap/latest/analyze/creating-tools/a-quick-tour-of-python-

toolboxes.htm

10.1 Structure of the scripts in the pre-processing tool

The WRF-Hydro pre-processing tool is split between two python scripts. The first is the
‘GEOGRID_STANDALONE.pyt’ file, which contains the classes and syntax necessary to construct the
Python Toolbox and handle parameters. The second script, wrf_hydro_functions.py, contains all of the
functions necessary to perform the pre-processing and associated workflows. The separation of these
scripts allows for modular development of custom tools and toolboxes, which can be built upon the
existing functions in wrf_hydro_functions.py. There are also .xml files for each script tool that describe
the tool and any tool parameter descriptions. The scripts must be located in the same directory at all
times. See ‘2.2 Toolbox Design’ for more information.

10.2 Editing the scripts

Users may modify the Python script as they wish according to the terms of the license, though it is a
good idea to keep a copy of the original version should your modification efforts introduce errors. To
open the script from within ArcGIS, right-click on the toolbox and select edit. The default Python editor
(IDLE) will open and the script may be edited. You may have to customize your Python installation in
order to recognize .pyt files. See http://blogs.esri.com/esri/arcgis/2012/12/14/how-to-debug-python-
toolboxes-in-3-easy-steps/ for more information.

10.3 After making script changes

ArcGIS and ArcMap use XML (.xml) files to describe the Python toolbox. Deleting these changes will
delete helpful parameter descriptions used in the tool dialog. After script changes are made, right click
on the toolbox from within ArcMap or ArcCatalog and ‘refresh’. This should allow ArcGIS to recognize
the script changes. Testing revealed that the tool behavior may not change until this step has been
completed. Further, periodically deleting files in the user’s TEMP directory may be necessary.

11 Future Compatibilities

11.1 Customized Channel Initiation

One method that is employed in building the NOAA National Water Model is to attempt to imitate the
observed channel density on the WRF-Hydro CHANNELGRID variable. Currently, the channel density is
defined by a global threshold supplied by the user in the ‘Number of routing grid cells to define
stream’ parameter. If the most upstream points on a network are known, these points can be used to
weight the flow accumulation grid and produce a channel density similar to an existing hydrography
dataset (such as NHDPIus, for example). This capability may be added to the WRF-Hydro GIS pre-
processing tools in the near future to allow for more realistic channel densities to be modeled.
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